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® All Rights Reserved 

 

No part of this publication may be reproduced, stored in a retrieval system, or 

transmitted in any form or by any means, electronic, mechanical, photocopied, 

recorded, scanned, or otherwise, except as permitted under U.S copyright 

law, without the prior written permission of the author. 

 

Notes to the Reader: 

 

While the authors of this book have made reasonable efforts to ensure the 

accuracy and timeliness of the information contained herein, the author and 

publisher assume no liability with respect to loss or damage caused, or 

alleged to be caused, by any reliance on any information contained herein 

and disclaim any and all warranties, expressed or implied, as to the accuracy 

or reliability of said information. The authors make no representations or 

warranties with respect to the accuracy or completeness of the contents of 

this work and specifically disclaim all warranties. The advice and strategies 

contained herein may not be suitable for every situation. It is the complete 

responsibility of the reader to ensure they are adhering to all local, regional 

and national laws. 

 

This publication is designed to provide accurate and authoritative information 

in regard to the subject matter covered. It is sold with the understanding that 

the authors are not engaged in rendering professional services. If legal, 

accounting, medical, psychological, or any other expert assistance is required, 

the services of a competent professional should be sought. 

 

Success in any business is result of hard work, time, effort and a variety of 

other factors. No expressed or implied guarantees of income or spillover are 

made by reading this work, or by joining and/or purchasing any program(s) 

recommended within this work. Individual results may vary.  
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Author’s Note  

Hi There, 

 

It's Chris here. Just a little background on myself… I've worked in various 

marketing agencies for more than 9 years. However I was forced to retire 

early at the age of 33 due to some chronic back injuries. Because of that, I 

lost my day job. You know how big corporate companies are like. Lose 

your value and out the door you go. 

 

Forced into a corner, I had no other choice but to turn to the internet to try 

to earn some income. I've tried countless programs, recommended by 

business magazines or my friends on the internet. Unfortunately a lot of 

them were hard to implement or just plain scams. You should be familiar 

with this if you're reading this now. =) 

 

It was a hard route and it was only through trial and error that I finally made 

it. After mastering the art and science of marketing online, I'm happy to say 

that I now earn a steady 5 figure income every month. People regularly 

invite me to speak at seminars and I'm a much sought after speaker too. 

Life is just good. 

 

Now I would love for you to have this similar opportunity, to actually create 

massive wealth beyond your wildest dreams. With this program you'll find 

the secrets to success, all laid out in simple step-by-step instructions. As 

long as you are willing to learn and commit yourself, you too would be able 

to enjoy a worry-free and financially abundant lifestyle. 

 

Your journey starts today.  

 

Keeping it real, 

Chris Cole 
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Introduction 
 
This document is a detailed guide for using the “Ad Word Analyzer”. 
Instructions for each of the tasks are located in the appropriated sections of 
this guide. 
 

Installation Procedure 

 
In order to begin installing the “Ad Word Analyzer” double click the 
“AdWordAnalyzer.exe” file. The following screen will be displayed. 
 

 
Figure 1: Installation procedure (step 1/6) 

 
In order to continue installing “Ad Word Analyzer”, click on the “Next” button 
and the “License Agreement” screen will be displayed. 
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Figure 2: Installation procedure (step 2/6) 

 
 
Select the “I accept the terms of the license agreement” radio button and click 
the “Next” button. The following screen will be displayed. 
 

 
Figure 3: Installation procedure (step 3/6) 
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You can choose to install the application to the default directory or set the 
desired folder by clicking the “Change” button. Once you have defined the 
destination location, click the “Next” button. The following screen will be 
displayed. 
 

 
Figure 4: Installation procedure (step 4/6) 

 
 
Inside this screen you can still determine to go back and change the settings, 
or click the “Install” button in order to install the application. The following 
screen will be displayed once you click the “Install” button. 
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Figure 5: Installation procedure (step 5/6) 

 
 
The progress indicator will be displayed. Wait until it reaches the end and the 
following screen will be displayed. 
 

 
Figure 6: Installation procedure (step 6/6) 
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The “Ad Word Analyzer” requires a computer restart prior to starting it for the 
first time. Choose to restart it immediately or at some other point and click on 
the “Finish” button in order to complete the installation procedure. 
 
 

Ad Word Analyzer Interface 
 
This section of the document will give the definition of the “Ad Word Analyzer” 
interface. The interface contains the following elements: 

 File Menu – see section 0 for further information 

 Datacenters Menu - see section 0 for further information 

 AdWords Tools Menu – see section 0 for further information 

 Window Menu – see section 0 for further information 

 New Search – option for performing the new search concurrently 
o Note: the number of searches that can be performed 

concurrently is mostly function of available bandwidth, 
broadband connections such as Cable, DSL or Wireless 
allowing for a larger number of concurrent keyword searches. 

 Open Saved Report – option for opening a previously saved report 

 User’s Manual – option for accessing this manual 

 Report Menu – see section 0 for further information 

 Edit Menu - see section 0 for further information 

 View Menu - see section 0 for further information 

 Item Menu - see section 0 for further information 

 Keyword Saving - option for choosing whether the keywords will be 
saved with "Quotes", "No Quotes" or "No brackets" 

 Stop Search – option for stopping the search currently visible inside 
the results screen 

 Save as AWA Report – option for saving the results so you can 
access them and use them subsequently (see section 0) 

 Save as CSV Report – option for saving the results as CSV Report 
(see section ) 

 Save Keywords – option for saving the keywords (see section 0 for 
further information about saving the keywords) 

 Print Report – option for printing the report 

 Use Quotes – use this option to add quotes to the search 

 Start Search – option for starting the search 
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Figure 7: Ad Word Analyzer Interface 

 

Performing the Search 
 
In order to perform a search, choose the desired method (Google Sandbox, 
Wordtracker. Text File or Master Keywords File – see section 0), enter the 
desired keywords and click on the “Start Search” button. 
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Figure 8: Performing the search 

 
 
The dialog for solving the CAPTCHA image will be displayed. 

 
Figure 9: Solving the CAPTCHA 

 
 
Enter the characters and numbers displayed in the image and click “Continue” 
and Ad Word Analyzer will begin fetching the keywords. 
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Figure 10: Ad Word Analyzer fetching the keywords 

 
 
After a few moments, Ad Word Analyzer will begin displaying the keyboards 
you will be able to monitor the progress at the bottom of the screen. 
 

 
Figure 11: Searching for the keyword 

 
 
Note: the search may take a while depending on your internet connection 
speed and the number of available results. 
After the search has been performed you will have various options such as: 

 Saving the results – there are several possible formats for saving the 
results including CVS, HTML and AWA format 
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 Performing a new search from the selected keyword – to perform a 
new search from the selected keyword, right click the desired keyword 
and choose the “Launch in new search window” option 

 Collecting adwords CPC and Daily Clicks – see section 0 

 Displaying the competitive ads – see section 0 

 Filtering the results – see section 0 
 

Each of the procedures are explained in detail in the rest of this document. 
Notes: 

 By default, Ad Word Analyzer will save all results in the results window. 
However keywords can be deselected if required by clicking the gray 
box at the top left of the results next to “Keyword Phrase” 

 In addition if you want to exclude particular keyword in order to omit it 
from files used for saving the keywords, select the checkbox next to the 
desired keyword 

 If you only want to save the selected keywords, then use the “Save 
Keywords As” option from the “File” menu; this option is located under 
“File” on the main menu only, and will allow results to be saved as a 
plain text file, with quotes or brackets if the option was selected during 
the search process. Selecting this option will open a window where the 
file name and location where the results text file is to be saved can be 
specified. This is the option to use when only saving the selected, 
checked keywords displayed on the results screen rather than all 
keywords 

 Save Keywords: this option will save the results in a file called by 
default “mykeywords.txt”. This file is created within a directory called 
“My Keywords” which in turn is located in the “My Documents” directory 
within the “Documents and Settings” for the current Windows user 
name. This option can only be used to save all of the displayed 
keywords in the results screen. 

 Results are appended to the end of the last results to be stored in that 
file, and are stored either in plain text format with one result per line, or 
with the quotes or square brackets as qualifiers depending on the 
options specified during the search process. 

 Duplicate keywords will not be saved to text files when using the “Save 
Keywords” or “Save Keywords As” menu options 

 After one or more keyword lists have been saved as text files, they will 
become available in the drop-down menu next to the “Search with” 
menu option 

 When starting a new search Ad Word Analyzer looks in the “My 
Keywords” directory to determine what files already exist, and as new 
text files are added, Ad Word Analyzer will include this file at the end of 
the “Search with” drop-down menu 
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 Selecting a file from the “Search with” drop-down menu will allow the 
searching of all keywords saved within that particular file 

 

Methods for performing the search 

 
This section of the document will give further information about each of the 
possible methods for performing the search. Use one of the desired methods 
prior to clicking on the “Start Search” button. 
 

 
Figure 12: Choosing the desired search method 

 
 

 Google Sandbox Tool - this option will query Google's keyword tool 
for the selected keyword and related keywords 

 Wordtracker- this option will query the Wordtracker Suggestion Tool 
for the selected keyword and related keywords 

 File - this option will query a specified file for the selected keyword 

 Master Keyword File - This option will query the file “mykeywords.txt” 
which is created by the “Save keyword” option, and located in a 
directory “My Keywords” in the “My Documents” directory in 
“Documents and Settings” for the current Windows user name 

 

Use these methods in combination with Datacenter options for further defining 
search (see section 0 for further information). 
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Collecting AdWords CPC and Daily Clicks 

 
Once the search has been completed, the “Ad Word Analyzer” will display a 
dialog window asking you if you would like to collect AdWords CPC & Daily 
Clicks estimate. 

 
Figure 13: Collecting AdWords CPC and Daily Clicks (step 1/2) 

 
Click on the “Yes” button and the dialog window for entering your Ad Word 
account information will be displayed. 
 

 
Figure 14: Collecting AdWords CPC and Daily Clicks (step 2/2) 

 
Enter your AdWord username and password and click on the “Continue 
Query” button. The “AdWord Analyzer” will collect the data and display it 
inside the results window. 

 
Figure 15: Data collected 
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Showing the Competing Ads 

 
Once you have finished the search (see section 0) you can show the 
competing ads for a desired result. Right click the result and choose option 
“Show Competing Ads”. 
 

 
Figure 16: Viewing the competing ads (step 1/2) 

 
The screen with the competing ads will be displayed. 
 

 
Figure 17: Viewing the competing ads (step 2/2) 
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Using the File Menu 
 
In order to start using the File menu, choose option “File” from the main menu. 
 

 
Figure 18: Using the file menu 

 
The following options are available inside the file menu: 

 New Search – option for performing a new search (see section 0) 

 Open – option for opening a previously saved reports 

 Program Settings – option for adjusting the program settings (see 
section 0) 

 Exit – option for exiting Ad Word Analyzer 
 

Adjusting the Program Settings 

In order to start adjusting the program settings, choose option “Program 
Settings” from the file menu. 

 
Figure 19: Choosing option "Program Settings" 
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The following screen will be displayed. 
 

 
Figure 20: Managing the program settings 

 
The following parameters are available inside this screen: 

 Regional Settings: 
o I want to analyze campaigns from my country – choose this 

option to analyze the local campaigns 
o I want to analyze US campaigns – choose this option in case 

you want to analyze US campaigns 
o Google datacenter - This setting determines the datacenters to 

be polled by Ad Word Analyzer for Google datacenters. The 
default setting is “www.google.com”. Select “www-
sj.google.com” if you are outside US and would like to see US 
campaigns. 

 Timeout: This setting determines the time that a search will be 
terminated due to search engine inactivity. If the setting is left at the 
default of “0”, a search will never time out and Ad Word Analyzer will 
continue polling the search engine until results are returned. You can 
also specify the number of pages after which the Ad Word Analyzer will 
stop searching 

 User agent: This setting determines how Ad Word Analyzer identifies 
itself to the search engines when connecting and polling for results. 
The default setting is “Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 
5.0)”, which will result in the search engines identifying the connection 
as originating from this type of browser. Although an alternative form of 
connection agent identification can be placed in this option, it is 
recommended that it be left set at the default setting. 
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 Keyword Saving – use this option to specify the method for saving the 
keywords 

 Additional options: There are two additional options available: 
o Auto scroll results will cause results to automatically scroll as 

they are received from the search engines 
o Use quotes on search terms will place quotes around the 

results of the selected search term 
o Play a sound when searches complete – use this option to 

play a sound to indicate that the search has been completed 

  - use this option to set a custom sounds 

  - use this option to preview the selected sound 
To save the configuration, click on the “OK” button. 
Note: should it be necessary to restore the options to the Ad Word Analyzer 
default settings, simply click “Reset to Defaults”. 
 
 

Using Datacenters Menu 
 
In order to start using “Datacenters” menu, choose option “Datacenter” from 
the main menu. 
 

 
Figure 21: Using the Datacenters Menu 

 
 
The following options are available inside this menu: 

 Google – use this option to choose the country Google search will be 
applied for 

 Perform Google Ad Count Lookups– check this option to have “Ad 
Word Analyzer” perform Google Ad Count lookups 

 Perform MSN Ad Count Lookups – check this option to have “Ad 
Word Analyzer” perform MSN Ad Count lookups 
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Using AdWords Tools Menu 
 
In order to start using the “AdWords Tools” menu, choose option “AdWords 
Tools” from the main menu. Click on any of the options to visit the website 
and familiarize yourself with each of the available tools. 
 

 
Figure 22: Using AdWords Tools Menu 

 
The following options are available inside this screen: 

 Competition Equalizer 

 Ad Word Generator 

 Google Cash 
 

Using Window Menu 
 
Searches being performed concurrently can be viewed, stopped and sorted 
alternately by selecting “Window” from the main menu where all current 
search sessions will be listed, and selecting the appropriate keyword search 
session from the end of the Window menu. 

 
Figure 23: Using the Window menu 
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The following options are available inside this screen: 
 

 New Window – use this option to open a new search window 

 Cascade – use this option to cascade the searches 

 Tile Vertical - use this option to tile the searches vertically 

 Tile Horizontal – use this option to tile the searches horizontally 

 Close All – use this option to close all open search windows 

 Arrange Icons – use this option to arrange the icons 

 List of current searches – this part of the menu will list all current 
searches 

 

Using the Report Menu 
 
In order to start using report menu, choose option “Report” from the toolbar 
menu. 
 

 
Figure 24: Using the report menu 

 
The following options are available inside this screen: 

 Collect/Refresh CPC Data – use this option to collect CPC data (note: 
you need to have a valid AdWords login for access) 

 Save as CSV – choose this option to save the report as CSV format 
(comma separated value) – see section 0 

 Save as HTML – choose this option to save the report as HTML file 
(see section 0) 

 Save Keywords – choose this option to save the keywords in text 
format under the name “My Keywords.txt” (note: when starting a new 
search Ad Word Analyzer looks in the “My Keywords” directory to 
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determine what files already exist, and as new text files are added, Ad 
Word Analyzer will add will include this file at the end of the “Search 
with” drop-down menu) 

 Save Keywords As - choose this option to save the keywords in text 
format under the desired name (note: when saving to keywords to the 
same file, "Ad Word Analyzer" will prompt if you would like to append 
the data to existing file; this option is used to add more data to an 
existing file; use this option If only selected keywords should be saved 

o Notes: 
 duplicate keywords will not be saved to text files when 

using the “Save Keywords” or “Save Keywords As” menu 
options 

 after one or more keyword lists as text files have been 
saved, they will become available in the drop-down menu 
next to the “Search with” menu option 

 Save as AWA Report – choose this option to save the report as full 
“Ad Word Analyzer” report saving all the preferences so you can 
continue working on the report subsequently (note: the format of the 
file is .awa) – see section 0 

 Print – choose this option to print the report 

 Close – option for closing the current search window 
 

Saving report as CVS 

 
In order to save the report as CVS (comma separated value), choose option 
“Save as CSV” from the “Report” menu. 
 

 
Figure 25: Saving report as CSV file (step 1/2) 

 
The dialog window for choosing the file name and location will be displayed. 
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Figure 26: Saving report as CSV file (step 2/2) 

 
Click on the “Save as CSV” button and the report will be saved. 

 
Figure 27: Example of the report saved as CSV 
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Note: the CSV file can be opened with “Excel” 
 

Saving report as HTML 

In order to save the report in HTML format, choose option “Save as HTML” 
from the “Report” menu. 
 

 
Figure 28: Saving the report in HTML format (step 1/2) 

 
The dialog window for choosing the file name and location will be displayed. 
 

 
Figure 29: Saving the report in HTML format (step 2/2) 
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Click on the “Save as HTML” button and the report will be saved. 
 

 
Figure 30: Example of the report in HTML format 

Saving report as AWA report 

 
In order to save the report in AWA (Ad Word Analyzer) format, choose option 
“Save as AWA Report” from the “Report” menu. 

 
Figure 31: Saving report as AWA report (step 1/2) 
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The dialog window for choosing the file name and location will be displayed. 
 

 
Figure 32: Saving report as AWA report (step 2/2) 

 
Click on the “Save as AWA” button and the report will be saved. 
Note: when saving to keywords to an existing report, "Ad Word Analyzer" will 
prompt if you would like to append the data to existing file; this option is used 
to add more data to an existing report). 

Using the Edit Menu 
In order to start using edit menu, choose option “Edit” from the toolbar menu. 

 
Figure 33: Using the edit menu 
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The following options are available inside the edit menu: 

 Select All – option for selecting all results 

 Delete Selected – option for deleting a selected result; select the 
desired result and click on this button in order to delete it 

 Tag Selected – use this option to tag the selected result 

 Remove Tags – use this option to remove all tags 
 

Using the View Menu 
 
In order to start using view menu, choose option “View” from the toolbar 
menu. 
 

 
Figure 34: Using the View Menu 

 
The following options are available inside the “View” menu: 

 Fields – option for managing fields that will be displayed inside the 
results window (see section 0) 

 Filter Results – option for filtering the results (see section 0) 
 

Managing fields inside the results window 

In order to start managing fields that will be displayed inside the results 
window, choose option “Fields” from the view menu and select or deselect the 
desired fields. 
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Figure 35: Managing fields displayed inside the results page 

 

 Tagged – click on this field to remove or enable the checkboxes next 
to the results 

 Keyword – choose this field to remove or enable keywords inside the 
results window 

 Searches – click on this field to remove or enable the number of 
searches 

 Results – click on this field to remove or enable results 

 R/S – click on this field to display the R/S Ratio inside the results page 
o Note: this number represents a ratio of Results and Searches, 

and is derived by dividing the total number of pages in the 
database index by the total number of times the corresponding 
keyword was searched for. Generally, the lower the R/S Ratio 
the better the keyword, with the provison that to be really 
meaningful the larger the number of searches for that particular 
keyword the more useful it should be. Clicking on the “R/S 
Ratio” heading successively alternates between the highest and 
lowest results based on R/S Ratio. 

 KEI – click on this field to display the KEI inside the results page 
o Notes: 

 Keyword Effectiveness Index; the higher the KEI, the 
more popular the keywords are, and the less competition 
they have, which means they have a better chance of 
getting to the top 

 KEI data is only available on reports collected with the 
“Use Quotes” option enabled 

 Google Ads – click on this field to remove or enable the number of 
Google Ads for the result 

 MSN Ads - – click on this field to remove or enable the number of MSN 
Ads for the result 
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 # 1 CPC – click on this field to remove or enable the amount for CPC 
(Cost Per Click) 

 Est. Clicks – click this field to remove or enable the number of 
estimated daily clicks 
 

Filtering Results 

 
In order to start filtering the result once you have finished your search (see 
section 0), choose option “Filter Results” from the View menu. 
 
 

 
Figure 36: Filtering search results 

 
The following options are available for filtering the results: 

 Low Google Adword Competition - click on this option to filter the 
results based on how low the Ad competition is for the result on Google 

 Low MSN Ad Competition - click on this option to filter the results 
based on how low the Ad competition is for the result on MSN 

 First Page Ads - click on this option to filter the results based on first 
page Ad opportunities 

 Lowest R/S Ratio - click on this option to filter the results based the 
lowest R/S Ratio 

o Note: This number represents a ratio of Results and Searches, 
and is derived by dividing the total number of pages in the 
database index by the total number of times the corresponding 
keyword was searched for. Generally, the lower the R/S Ratio 
the better the keyword, with the proviso that to be really 
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meaningful the larger the number of searches for that particular 
keyword the more useful it should be. Clicking on the “R/S 
Ratio” heading successively alternates between the highest and 
lowest results based on R/S Ratio 

 Most Popular Keywords - click on this option to filter the results 
based on most popular keywords 

 Best KEI Ratio - click on this option to filter the results based on best 
KEI ratio 

o Notes: 
 Keyword Effectiveness Index; the higher the KEI, the 

more popular the keywords are, and the less competition 
they have, which means they have a better chance of 
getting to the top 

 KEI data is only available on reports collected with the 
“Use Quotes” option enabled 

 Lowest CPC – click on this option to filter the results based on lowest 
cost per click 

 Highest Daily Ad Clicks - click on this option to filter the results based 
on highest daily Ad clicks 

 Custom Filters - click on this option to filter the results based on 
custom filter (see section 0) for further information on setting up a 
custom filter 

 Clear Filter – use this option to clear the filters 

Setting up Custom Filter 

In order to setup a custom filter, choose option “Custom Filter” from the “Filter 
Results” menu. The following screen will be displayed. 
 

 
Figure 37: Setting up a custom filter 

 
The following parameters and options are available inside this screen: 

 Custom Filter – pull down menu for choosing a previously defined 
custom filter 

 Greater Than – enter “–1” in order to disable filtering for the desired 
category or enter a value in desired categories to define the filter 
criteria 

 Less Than - enter “–1” in order to disable filtering for the desired 
category or enter a value in desired categories to define the filter 
criteria 
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 Reset Current Filter – option for resetting the values of the currently 
loaded filter 

 Save As Custom Filter – option for saving a custom filter once you 
have defined the desired data 

 Apply Filter – option for applying the chosen filter 

 Cancel – option for exiting this screen 
 

In order to define a custom filter, set the desired data and click on the “Save 
As Custom Filter” button. The screen for setting the custom filter name will be 
displayed. 
 

 
Figure 38: Setting the custom filter name 

 
Enter the name of the custom filter inside this screen and click on the “OK” 
button. The custom filter will be saved and available in the menu for future 
use. 
 

Using the Item Menu 
 
In order to start using item menu, choose option “Item” from the toolbar menu. 

 
Figure 39: Using the item menu 

 
The following options are available inside this screen: 
 

 Launch in new search window – option for displaying the selected 
result in a new search window in order to allow deeper analysis 
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 Show competing ads – option for displaying the ads competing for the 
same keyword (see section 0) 

 Open as Google Search – click on this button to open this search in 
Google; results will be displayed in your default browser 

 Open as MSN Search - click on this button to open this search in 
MSN; results will be displayed in your default browser 
 

Saving the keywords 
 
In order to save the keywords into a text file, click on the “Save Keywords” 
button inside the toolbar menu. 
 

 
Figure 40: Saving the keywords 

 
The confirmation dialog window will be displayed containing the address of 
the saved file. 
 

 
Figure 41: Keywords saved 

 

Notes: 

 duplicate keywords will not be saved to text files when using the “Save Keywords” or 
“Save Keywords As” menu options 

 after one or more keyword lists as text files have been saved, they will become 
available in the drop-down menu next to the “Search with” menu option 
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 when starting a new search Ad Word Analyzer will look in the “My Keywords” 
directory to determine what files already exist, and as new text files are added, Ad 
Word Analyzer will add new file at the end of the “Search with” drop-down menu 

 selecting a file from the “Search with” drop-down menu will allow the searching of all 
keywords saved within that particular file. 

 
 
 

Yours truly, 

 
Chris Cole 


